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 My favorite subjects are mainly emissions nebulae that 
populate our Milky Way

 My work in astrophotography is characterized firstly by the 
technical and scientific challenges posed by the capture of 
deep sky objects and then, for aesthetic sensibility, 
philosophical and poetic that allow transform them to 
beautiful and colorful images

 To capture the beauty of these fascinating objects, I use both 
narrowband and broadband imaging technique

 My aim when I am working on astronomical image, is to stay 
fully involved and focused on the aesthetic feeling that can 
emerge during the image processing



 In this workshop I will explain how I use all the following software to create wide-
field mosaics  and compose LRGB images in false colors :

 MaximDL 6 for capture and guiding

 SharpLock 1.0 as an autofocuser

 SkySurveyor 2.0 to plan and capture mosaic

 CCDStack 2.76 for calibration, registration and stacking

 Registar 1.0.7 for mosaic stitching

 PixInsight 1.8  for mosaic stitching and post processing

 PhotoShop CE for post processing



 I am always been fascinated by the views of large sky areas, especially images 
with a lot of details that use pleasing color palettes and offers very aesthetic 
feeling

 In order to build such images I have developed my astronomical skills in doing 
large scale mosaic

 Doing a mosaic with a lot of details requires accurate high focal length 
instrumentations and a lot of time and efforts to achieve all the necessary steps

 According to the weather conditions a wide field mosaic project requires several 
months to several years to complete



 When starting a mosaic project we must be aware of the following rules and constraints:
 The higher is the focal length, the smaller is the field of view

 The smaller is the field of view, the higher is the number of tiles

 The smaller is the sensor size, the smaller is the field of view

 The bigger is the sensor size, the higher is the required quality of the lens and the cost of the camera

 The higher is the focal length, the better will be the resolution of structural details

 The higher is the focal length, the bigger is the impact of the weather conditions

 The higher is the number of tiles, the harder is the work to make a seamless image

 The above rules teach us that there is no trivial solution; there is no way to cheat 

 We will never get a highly detailed image with short focal length instrument and a 
minimum of time and efforts

 All engineers knows that to get an optimal solution the only way is to reach a subtle 
equilibrium between all physical aspects and constraints of a given system



 The expected result will never be perfect, but it can be as close as possible to the optimum 
that can be reached with available instrumentations, the allocated time and the deal of 
efforts

 I have developed SkySurveyor to help astrophotographers doing all tasks of such a 
demanding mosaic project

 SkySurveyor help to:
 Choose a subject

 Find right ascension (RA) and declination (DEC) coordinates of a named object from SIMBAD

 Watch the extent of the subject using several  bandwidth among multiple background imagery (Color, H-alpha, 
Infrared, Ultraviolet, X-ray, Gamma, …)

 Define the field of a subject

 Frame the subject as close as possible interactively  on the sky map or by doing small coordinates adjustments

 Identify the area framed by the sensor as a function of the focal length and the size of the sensor



 SkySurveyor help to (continued): 
 Work with various focal length and sensor size

 Work with various cameras and filter wheels

 Work with various telescope mounts

 Divide the mosaic field into tiles

 Manage the overlap margin between tiles in order to ensure successful stitching 

 Slant mosaic in order to fit the subject orientation as much as possible

 Choose the starting point of the mosaic

 Choose the orientation of the sensor

 Define how the telescope will move across all tiles of the mosaic

 Define how many images (subs) that must be captured per tile

 Define the exposure time of each image

 Select filters that will be used 

 Give an order to the images to capture

 Use guider and define guide star exposure time per tile

 Check how close is the moon from the fields that will be captured to minimize light gradient



IN MY PRACTICE OF ASTROPHOTOGRAPHY I LET MYSELF BE 
DIRECTED BY THE AESTHETIC FEELING AND BY THE 

CHROMATIC RANGE GIVEN BY THE HUBBLE PALETTE TO 
MAKE IMPRESSIONIST ASTROPHOTOGRAPHY

Joseph Mallord William Turner
The Burning of the House of Lords and Commons, 16th October 1834

© Philadelphia Museum of Art

The Burning California, 8 pannels mosaic, 
September 2013 - October 2014

© David Lindemann

THE IMPRESSIONIST PAINTERS OF THE 19TH-CENTURY ARE ABLE TO CATCH
THE FEELING PROVIDED BY NATURAL PHENOMENON IN A VERY AESTHETIC 

RENDERING AND VERY IMPRESSIVE COLOR PALETTE



 This workshop is divided in 216 slides organized in 12 chapters :
 Chapter 1: Rising of a mosaic project

 Chapter 2: Sensor alignment

 Chapter 3: Data acquisition

 Chapter 4: Preprocessing (Calibration)

 Chapter 5: Data quality evaluation

 Chapter 6: Registration (Alignment) 

 Chapter 7: Data rejection and stacking

 Chapter 8: Mosaic stitching

 Chapter 9: Creating luminance master frame

 Chapter 10: Bringing out the structural details

 Chapter 11: Creating chrominance master frame

 Chapter 12: Blending luminance with chrominance



Elephant'sTrunk nebula (9 panels mosaic)



 Rising of a mosaic project seems trivial at the beginning but this is much more 
complex that what one can imagine  

 The first step consists in the selection of a subject
 What are the coordinates of the subject?

 How big is the subject?

 How far goes the extent of the subject?

 What kinds of objects are visible in the field of the mosaic? 

(Galaxies, Star clusters, Emission nebulae, Reflection nebulae, …)

 The second step consists of how much the image should be deep and how the 
mosaic will be captured
 What is the weaker signal we want to see in the final image? (usually the extensions) 

 What is the nature of the light emitted or reflected by the objects? (narrowband or broadband)

 What kind of instrumentations (focal length and sensors) we can use for capturing?

 How to identify the area framed by the sensor as a function of the focal length and the size of the 
sensor?



 How many tiles are required to complete the mosaic?

 How is the orientation of the subject?

 How to find what is the best orientation for the sensors?

 How to move the telescope from tile to tile to avoid leaving holes?

 How long must be the exposure time of a single subframe?

 How many single subframe are required to get a good signal to noise ratio?

 Choose the starting point of the mosaic and how the capture process will progress?

 How many nights are required to capture all?

 I can do this project myself or should I make collaboration with other astrophotographers?

 One key step when starting a mosaic project is to precisely identify the area 
framed by the available instrumentations. This area is called the Field Of View 
(FOV)

 The FOV is very important to be able to calculate the center coordinates and the 
total number of tiles required to entirely frame the subject



 Without a software able to manage mosaic and to do this calculation, we must 
calculate the FOV by using the following maths

 At beginning, the FOV of one pixel must be calcualted by using the following 
formula:

206𝑃

𝐹
= FOV of one pixel in arcseconds

Where P is the size of pixel in microns and F is the focal length in millimeters

 If the sensor pixel is not square, the pixel FOV must be calculated in both 
dimensions (height and width)



 To calculate the FOV of the whole sensor the FOV of a pixel must be multiplied by the number of 
pixels in both dimensions (height and width)

206𝑃

𝐹
𝑊 = FOV of the sensor width in arcseconds = WFOV

Where W is the width of the sensor in number of pixels

206𝑃

𝐹
𝐻 = FOV of the sensor height in arcseconds = HFOV

Where H is the height of the sensor in number of pixels

 To get the FOV in degrees, the WFOV and HFOV must be divided by 3600

 The FOV in degrees is required to calculate RA and DEC coordinates of each tile center point and to 
know the FOV of a tile



 To calculate the RA coordinate from degrees to hours the FOV must be divided by 15 
 one hour is equal to 15° (24 hours x 15° = 360°)

 With rectangular sensor this is very important to know its orientation before starting to calculate the 
coordinates of the center point of each tile

 To ease the calculation I strongly recommend to align the sensor orthogonally on the equatorial grid

 Orthogonal alignment means that both dimensions of the sensor are parallel to the equatorial grid

 With rectangular sensor, two orientations can be chosen:
 Portrait = longest dimension of the sensor is aligned to be parallel to the DEC axis

 Landscape = longest dimension of the sensor is aligned to be parallel to the RA axis

 Before calculating the center coordinates of each tile by using the WFOV and HFOV offset, I strongly 
recommand to subtract an overlap margin that will be necessary to make a good mosaic stitching

 This margin must be large enough (between 12% to 15% of the sensor FOV)



 As we use the FOV of the sensor as an 
offset of the RA coordinate to calculate the 
center coordinates of the next tile, the 
offset must be corrected with the 
declination

 Without correction (see red illustration) the 
overlap area between tiles increase in 
direction of celestial pole and decrease in 
direction of the celestial equator

 Toward Pole the mosaic become narrower

 Toward Equator the mosaic become wider

 With correction the overlap area remains 
constant (see green illustration)

narrower

wider



 To calculate the RA of center of the next tile and to take in account the 
declination the following formula is required:

𝛼 + 𝐹𝑂𝑉𝛼 −𝑀
1

1 cos
𝜋

180
𝐹𝑂𝑉𝛿

= 𝛼 of next tile

Where 𝛼 is the RA coordinate in arcseconds, 𝐹𝑂𝑉𝛼 is the field of view of the dimension of the  
sensor that is oriented parallel to the RA axis, 𝑀 is the overlap margin in arcseconds and 𝐹𝑂𝑉𝛿 is 
the field of view of the dimension of the  sensor that is oriented parallel to the DEC axis



 As I mentioned before, the orientation is very important, this avoids wrong coordinates 
calculation and leaving holes between an image and another 

 Without orthogonal alignment a rotation matrix must be applied to calculate the next tile 
coordinates:

𝑐𝑜𝑠𝜃 ⋯ −𝑠𝑖𝑛𝜃
⋮ ⋱ ⋮

𝑠𝑖𝑛𝜃 ⋯ 𝑐𝑜𝑠𝜃
= R

Where 𝜃 is the angle of the sensor and R is the rotation matrix

 Using a matrix makes the coordinates calculation very complex and the risk of wrong 
coordinates calculation and leaving holes between tiles is growing dramatically

 As we see, this is already not easy for one instrument but the complexity is growing if we 
plan to use multiple instruments and/or collaborate with other astrophotographers
because all that calculations must be repeated for every instrument



 SkySurveyor provide a good mean to address all that questions and to deliver us 
from this complex calculation job

 One of its key features is the WYSIWYG “What You See Is What You Get” user 
interface that allows the user to view something very similar to the end result 
while the project is being created

 WYSIWYG implies the ability to directly manipulate the images segments of a 
project without having to type or remember names of commands and without 
having to calculate geometric transformation to get the center of each tiles of 
the mosaic



 The user interface of SkySurveyor is divided in 4 zones:
1. The capture indicators (remaining time, number of images, and telescope location, …)

2. The interactive sky map

3. The command toolbars, the available object lists and their configuration settings

4. The working folder and the save command button

 

 

1 

2 3 

4

3 



 The sky map shows the field of every individual image of one or several mosaic at a time 
as a graphical overlay drawn above selectable background imagery

 By default the sky map start with the Digitized Sky Survey (color) background



 To pan the sky map, just click on the map with the 
right mouse button and hold the button down while 
moving the map to the directions indicated by the 
blue arrows

 To zoom in/out use the mouse wheel

 With a touch screen, pan the map with the finger by a 
simple touch and swipe

 The RA and DEC coordinates correspond to the 
location of the mouse cursor on the sky map

 The FOV correspond to the current field of view 
(range is between 0° and 60°), the FOV changes 
when zooming

 



 The imagery drop down list allows changing 
background sky map

 20 background sky maps in various bandwidths are 
available

 This bunch of background allows seeing how the 
project is overlapping the targeted object

 To make an example, we can select “Hydrogen 
Alpha Full Sky Map” and we can check if all 
extensions of the targeted object will be correctly 
framed or not

@LiveDemo



 With SkySurveyor we can configure all the instruments and see the FOV of each one 
directly on the sky map with graphical overlays

 To configure instruments, simply add them in the available instruments list 



 To add a new instrument click the button

 Once clicked a new instrument is added and 
selected

 The form that allows editing the instrument 
settings automatically displays new instrument

 All invalid fields are identified by this icon  

 The instrument cannot be used until all fields are 
valid

 To understand why a field is invalid, just move the 
mouse cursor on top of the invalid icon      and read 
what is displayed in the tooltip



 To configure the telescope mount, click the 
“Setup” button

 Select the appropriate mount driver in the 
drop down list of the “ASCOM Telescope 
Chooser” and click “OK” button to confirm

 Once the telescope mount is configured it 
become valid



 To configure the camera, click the “Setup” button

 SkySurveyor automatically load the camera and the 
filters that have been configured in MaximDL

 Once all fields are correctly filled, the instrument 
can be used to build a mosaic project



 To add a new mosaic click the button

 Once clicked a new mosaic is added and selected

 The form that allows editing the moasic settings 
automatically displays the new mosaic

 All invalid fields are identified by this icon  

 The instrument cannot be used until all fields are 
valid

 To understand why a field is invalid, just move the 
mouse cursor on top of the invalid icon       and read 
what is displayed in the tooltip



 The mosaic composition is driven by a 3 steps workflow:

 Define the mosaic

 Settle each tiles

 Release the mosaic for capturing

 The mosaic status cannot be set to a higher status than define until all fields are valid

 First enter the name of the object that is the main subject of the mosaic

 If the name of the object correspond to a reference in a official catalog (e.g. M42) the object RA 
and DEC coordinates can be automatically loaded from the SIMBAD Astronomical Database



 To get coordinates from SIMBAD, click the                     button

 If the object is referenced in SIMBAD, its RA & DEC coordinates are automatically loaded into the 
Right Ascension and Declination fields

The world database for the identification of astronomical objects



 Select an instrument from the available instruments:

 The next step is to define how the mosaic will be decomposed into tiles

 To do this there are various settings:



 The WYSIWYG user interface allows to easily defining the field 
of the mosaic by changing the tiling scheme

 Before defining the tiling scheme, its important to understand 
how the settings control the position and extent of the mosaic 
field

 The tiling scheme allows controlling …
 The number of tiles toward the direction of cardinal points

 The tile overlap margin in both direction (Right Ascension and Declination)

 The mosaic slant factor in both direction (Right Ascension and Declination)

 To increase / decrease the field of the mosaic toward North 
the DEC+ must be incremented / decremented

 To increase / decrease the field of the mosaic toward South 
the DEC- must be incremented / decremented

 To increase / decrease the field of the mosaic toward East the 
RA+ must be incremented / decremented

 To increase / decrease the field of the mosaic toward West the 
RA- must be incremented / decremented

Mosaic Upper Left Corner Mosaic Upper Right Corner

Mosaic Lower Right CornerMosaic Lower Left Corner

Tile Upper Right Corner
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 Shows in real time 
 How the field of the mosaic grows or shrink after editing the tiling scheme settings

 How the tiling scheme indicators are automatically recalculated

@LiveDemo

Tiling scheme
settings

Tiling scheme
indicators



 When the sizes of overlap margins between tiles increase or decrease the field of the mosaic grows or shrink in real 
time

 The field of the mosaic can also be adjusted by a double click on the sky map

 The coordinates of the center of the first tile of the mosaic can be easily adjusted by different options:

 Type the coordinate values directly on the corresponding field

 Slightly increment / decrement the coordinate values with the spinner placed at right side

 Use the buttons to increase / decrease the coordinate fields or to set coordinate to any corner tile

Buttons Meaning 

 
Decrease the coordinate by the field of one tile. 

 
Decrease the coordinate by the field of the mosaic. 

 
Increase the coordinate by the field of one tile. 

 
Increase the coordinate by the field of the mosaic. 

 
Set the mosaic RA & DEC coordinates to the center of the upper left 
corner tile. 

 
Set the mosaic RA & DEC coordinates to the center of the lower left 
corner tile. 

 
Set the mosaic RA & DEC coordinates to the center of the upper right 
corner tile. 

 
Set the mosaic RA & DEC coordinates to the center of the lower right 
corner tile. 

 



 Another cool adjustment feature is the ability to tilt (slant) the mosaic in order to frame the subject as close as 
possible

 This feature allows to adjust the orientation of the mosaic field without having to change the orientation of the 
sensor

 The slant factors are defined as a percentage of the tile FOV in the selected direction
 For example a slant factor set to 10% means that the center of the next tile will be offset by a value of 10% of the FOV 

in selected direction



 Now, it’s time to define how tiles will be numbered

 By default, the first tile begins with 1, the numbering begins with the lower-left corner and the number stepping is 
row by row

 The following tables show how the tiles will be numbered in various configurations:

Step by row 

Start at Upper Left Corner Start at Upper Right Corner 

  
Start at Lower Left Corner Start at Lower Right Corner 
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Step by column 

Start at Upper Left Corner Start at Upper Right Corner 

  
Start at Lower Left Corner Start at Lower Right Corner 
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 Now this is time to define the capture settings

 Capture settings allows defining how images will be captured for each tile

 Set the number of images per tile  

 Set the image start number  

 By default there is no delay between each capture, define a delay in seconds if needed

 Set the exposure time in seconds

 By default the binning is set to 1x1, adjust the binning if needed

 By default the telescope stay on the same tile until all subframes for all selected filters have been captured. Slew to next tile after each capture option allows 
to force the telescope to move to the next tile

 By default the dithering is disabled, define a value in pixels that will be randomly used during capture

 By default guiding is disabled, enable it to start guiding before capture

 If the guiding is enabled, define guider exposure in seconds

 If there is a filter wheel configured for the camera, select filters among the list of available filters given by the selected instrument

 Once all settings are properly defined, the mosaic project can be promoted to the next status

This option allows to 
smooth the capture by 

browsing all tiles 
during the same night 

in order to have 
homogeneous seeing 
conditions on all tiles.



 The “Settle” status allows dividing the mosaic into tiles according the tiling scheme previously defined

 Once the mosaic is divided into tiles, the FOV of every tile including the overlap margins are displayed as graphical 
overlays on the sky map

 Again, the WYSIWIG interface provides a good preview of how the final result will looks like

Orthogonal mosaic Slanted mosaic



 In “Settle” status, the settings of each tiles can be edited 
individually

 Each tile can be enabled/disabled 

 Interactive sky map allows to identify and disable a tile by 
double-clicking it on the sky map

 The order can also be adjusted by simply dragging & 
dropping items on the list

 The following settings can be adjusted on each tile:
 Number of image to capture

 Delay between each capture

 Exposure time

 Binning

 Enable/Disable guider and the guider exposure time

 The selected filters

 Once tiles haven been adjusted, the mosaic can be released 
for capture

NOTE : only enabled tiles will be captured



Butterfly and Crescent nebulae (12 panels mosaic)



 To capture deep sky mosaic we must be sure that the sensors are aligned

 When all panels are parallels the mosaic assembly process and the background level adjustment 
are simplified

There is no holes (non-captured areas); the 
margins between the tiles are well defined 

and regular

There are holes (non-captured areas), the 
margins between the tiles are irregular



 SkySurveyor is able to work with two sensor orientations

 To make sensor alignement, the first step is to assemble the sensor and the optical 
instrument in such a way that the sensor is as close as possible to the portrait or landscape 
orientation 

Landscape Portrait 

 

 
In landscape orientation the longer dimension 

must be parallel to the Right Ascension axis 
In portrait orientation the longer dimension 

must be parallel to the Declination axis 

 



 Choose a bright star and adjust the focus
 After focus adjustment, move the star to the center of the sensor



 When the star is centered, follow this workflow:
 Set mount slew speed at 0.5x the sidereal speed

 Set the exposure time to 245 seconds

 Start capture

 Wait 5 seconds before slewing the mount with the mount hand control pad

 After 5 seconds, press the « E » button to slew mount toward East

 Keep the « E » button pressed during 65 seconds

 When 65 seconds has elapsed, press the « W » button to slew mount toward West

 Keep the « W » button pressed during 60 seconds

 When 125 seconds has elapsed, press the « S » button to slew mount toward South

 Keep the « S » button pressed during 60 seconds

 When 185 seconds has elapsed, press the « N » button to slew mount toward South

 Keep the « N » button pressed during 60 seconds

 At the end of the integration time release the « N » button



 The move we just did must show a reversed « L » shape at the center of the captured 
image

 If the reversed « L » shape is aligned with the RA and DEC axis that means that the sensor 
is well aligned to the equatorial grid



 If the reversed « L » shape is aligned like the red one, then slightly rotate the sensor 
toward the left
 rotate the camera to the direction indicated by the red arrow

  



 If the reversed « L » shape is aligned like the red one, then slightly rotate the sensor 
toward the right
 rotate the camera to the direction indicated by the right arrow

 Once done, restart the procedure from beginning to check if the alignment is correct

 
 



Soul and heart nebulae (8 panels mosaic)

https://apod.nasa.gov/apod/ap161116.html



 The data acquisition is the most critical phase of any astronomical imaging project
 The main challenge consist of maximizing the clear night time to get the maximum number of subframes

 During the period where the object is above horizon and located inside the optimal altitude range in the sky

 As a mosaic project is much more demanding in term of total exposure time, number of subframes
and telescope targets than a single image project

 As clear nights can happen any time, it becomes very important to be able to optimize data capture 
as much as possible in order to be able to collect data when conditions are optimal

 To maintain a social life and ability to go to work with a fresh mind while enjoying clear nights to 
collect photons, I decided to develop an almost fully automated capture process

 To be usable, the automated capture process must be able to answer the following questions:
 The setup must be ready to capture within a time laps of less than 30 minutes?

 The system must be able to move the telescope mount to each targets automatically?

 The system must be able to monitor in real time the weather conditions and the health of the setup during the capture process?

 The system must be able to notify me without delay in case of any event 
▪ unsafe weather conditions 

▪ trouble with the setup or with the capture process?

 The instrument must stay perfectly focused during the full night without human intervention and interruption of the capture process?



 To be usable (continued):
 Each captured subframe must be automatically named in order to help me during the image 

selection, calibration, registration, integration and stitching?

 The setup must be shutdownable and placed in safe state in less than 5 minutes?

 The system must be able to restart the capture process at the same state it was stopped last time and 
must be able to continue data capture according the predefined capture plan?

 The mount must be able to make the pier flip without human intervention and interruption of the 
capture process?

 The first challenge in my way to automate the capture process was to build a 
shelter for my setup

 In 2013, I started to build a shelter with rolling roof and reinforced concrete 
base to hold my setup

 On top of the concrete base, I have installed a high end 10micron GM2000 
robotic telescope equatorial mount

 On both parallel dovetails I have installed a Takahashi FSQ 106 apochromatic 
refractor and a GSO RC 8” reflector
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 Experienced astrophotographers knows that the focus shift when the temperature is changing

 To keep their instruments perfectly focused along the full night, the experienced astrophotographers refocus 
them several times a night
 This task requires at least an interruption of the capture process and most of the time a human intervention

 My second challenge was to find a solution that keep my instruments perfectly focused during the capture time 
without interruption of the capture process and without human intervention



 After my speech at NEAIC 2015 in New York, I met a compatriot 
who lives in USA and who developed wonderful piece of 
engineering called ONAG XT

 The ONAG® XT is a full frame On-Axis guider (up to 50mm 
diagonal): https://www.innovationsforesight.com/products/full-
frame-on-axis-guider-onag-xm-unit-only/

 The ONAG® and software called SharpLock® allows keeping the 
instrument perfectly focused along the full night in a fully 
automated way

 The auto-focus operations are done in real time during the 
exposure by measuring the shape of the guide star and moving the 
focuser to restore the best focus

https://www.innovationsforesight.com/products/full-frame-on-axis-guider-onag-xm-unit-only/


 How it works  :

 The light coming from the scope enter in the ONAG® the visible light (from 370 to 750 nm) is 
reflected to the imager sensor and the infrared light (>750 nm) goes through the dichroic mirror

 Due to astigmatism caused by the dichroic beam splitter the shape of the guide star change 
according to the position of the focal point

Guide star at best focus Guide star at -0.4 mm inward Guide star at +0.4 outward 

   
 

 The software SharpLock measures the shape of the guide star at the rate of the exposure time

 When the shape of the guide star shows a trend that goes inward, SharpLock® moves the 
focuser outward to restore the best focus

 When the shape of the guide star shows a trend that goes outward, SharpLock® moves the 
focuser inward to restore the best focus

 The focuser move steps are very small and they can occur while capturing the image without 
any artifacts on it



 Another advantage provided by the ONAG is the stability of the infrared light

 IR light is less distorted by atmospheric effects than the visible light

 The guiding and the focusing are more accurate with IR light than visible light



 The third challenge was to build a control center allowing to remote control and monitor 
my setup while capturing

 To do that I have installed an Intel® NUC computer inside my observatory

 To monitor my setup while slewing, I have installed an IR cam inside my observatory

 To monitor the weather condition, I have installed a weather station, a sky quality meter 
and weather monitoring software



 On the observatory computer, I have installed the following software:
 MaximDL 6

 SharpLock 1.0

 AAG Cloud Watcher 7.20 (sky quality monitoring) 

 Weather Display 10.37j (weather conditions monitoring)

 SkySurveyor 2.0
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 The last challenge was the orchestration of the data acquisition process

 What does the orchestration means?
 Scheduling the capture process

 Following the predefined capture plan

 Giving a real time feedback that shows the field being captured as a graphical overlay on the sky 
map

 Giving indicators that show the telescope position, the mount pier side, the telescope altitude, the 
remaining capture time, the remaining number of images that must be captured, etc.

 Operating the telescope mount to automatically slew to the target coordinates

 Acquiring a guide star

 Starting the guider before exposing light

 Moving filter wheel to the selected filter

 Exposing light

 Retrieving the captured image

 Storing every image on the hard drive with a helpful naming convention

 Stopping the guider before operating the telescope mount

 Monitoring the scope position, guide star, the sky quality and the weather conditions 

 Sending notifications to smartphone in case of any trouble

 Managing the equatorial mount pier flip

 Capture only tiles that are above a given altitude

 Logging all events that occurs while capture in a text file



 This is done by  SkySurveyor

 When a mosaic project is released for capture, the capture backlog is filled with a list of capture task

 There is one capture task per single subframe



 While capture all tasks are processed from top to bottom and the interactive sky map move to the 
target tile and shows the telescope position in real time

 The capture indicators on top of the user interface are updated in real time

 The telescope position is marked by a red circle on the sky map

 This is very useful to monitor the capture process and to know which tile is being captured



 SkySurveyor allows defining constraints that can 
be applied at capture

 These constraints allow to define …
 A time frame

 An altitude threshold that must be reached

 If the project requires several nights, the time 
frame constraint help to predicate how many 
image will be captured during each night

 As an example the start capture time is set to 
23h00 and the stop capture time is set to 5h00

 All tasks that exceed the defined time frame are 
displayed in the list with the status “Out of time”

 All tasks with the status “Out of time” will not be 
captured and the capture indicators are 
automatically adjusted to shows what will be 
exactly captured during the time frame



 All tasks that are below the minimum 
altitude are displayed in the list with the 
status “Below altitude”

 All tasks that are below altitude are 
temporarily skipped and will be 
processed later on



 All operations that are done and all 
events that occur while captures are 
automatically logged into a text file and 
displayed in the user interface into an 
interactive list

 The last operation or event that 
happened is inserted on top of the list

 The capture process can be stopped at 
any time and restarted later

 When restarting the capture process the 
system automatically remember the 
state where it was last time and continue 
to capture the remaining tasks until the 
end



 SkySurveyor is able to send notifications directly to a 
smart phone via Pushover®

 This feature is very useful to warn in case of trouble 
while capturing

 With this cool feature, I am not be worried if I sleep 
during the capture process because in case of trouble 
the system will automatically wake me up

 The following events can be notified:
 If the target coordinates of a tile cannot be reached

 If the guide star is faded during a configurable number of iterations

 In case of any failure that occurs while capturing

 When capture is started

 When capture ends 

 When capture is aborted

 If the sky quality is below a predefined threshold

 If the wind speed exceed a given speed

 If the sky become overcast or if it rains

@LiveDemo



 Author, World Renowned Astrophotographer

 John Gleason’s life long passion has been wide field, highly detailed astrophotography -
in particular sweeping grayscale vistas of hydrogen alpha emission objects along the 
galactic equator. Over the last 5 years, John Gleason has embarked on a photographic 
odyssey to produce a personal CCD atlas of very deep H-a portraits of northern and 
southern hemisphere emission nebulae

 He has accepted to be my first beta tester for SkySurveyor V2

 As a first trial, He did a mosaic project on the Gum complex in Vela

 He send me the following testimonial :

The data capture is easy but this is not a novice software for a beginner. I think it requires a pretty
good knowledge of your full imaging system. But that is no different than most of the astronomical
software that is out in the market. For me, the planning aspect around the H-a sky map is
priceless. I can layout what I want to do and see how it will look. What you see defined on the map
is what you get!

I have also used the sky map to add tiles to existing mosaics by simply creating a new mosaic in
Surveyor and entering the known RA and DEC from one of my original tiles. Then I can add new
tiles in RA and DEC and be confident that I can mate them to the original mosaic. My 54 segment
Orion mosaic was recently completed this way.

Also..... my typical tile overlap is 40 arc minutes with the FSQ and 16803 at f/5, but because of the
precision of this entry in Surveyor, I can probably reduce that to 30 to 35 arc minutes. Slightly
wider coverage in a large array.

The northern 
edge of the 

Gum complex 
by John 
Gleason

FSQ @ f/5, 
Proline 16803, 

5nm 
Ha. 1800s x 6 

each tile

If you want to get a free release of SkySurveyor just send an email to : david.lindemann@netplus.ch



Rosette nebula



 A proper calibration is a very important step 
in astronomical image processing

 It must be done as best as possible to avoid 
loss

 Indeed, poor calibration is very destructive 
for the raw data and without calibration the 
noise and the optical train artifacts remains

 All monochromatic images acquired by the 
capture process must be calibrated 

 They are called Light frames
A light frame on Rosette nebula captured 28.12.2016 with Takahashi 
FSQ 106 @ f/5, Astrodon 5nm H-alpha filter, and Apogee Alta U8300 

monochrome cooled at -30° for 600 seconds of integration time



 Dark and Bias frames are used to calibrate the Light
frames

 They are taken in total darkness with the camera shutter 
closed or the lens covered

 The dark frame contains the bias signal and the thermal 
signal

 The thermal signal is the noise (dark current) that is 
summed over the length of an exposure

 The dark frames must be taken at the same temperature 
during the same integration time to properly 
characterize the thermal noise generated by the 
electronics of the sensor

 Subtracting the thermal signal allows to remove the 
majority of noise from a light frame

 Subtracting the dark also allows equalizing the signal by 
removing dead columns and dead pixels

 Dark frames are the more demanding calibration data 
because it requires several hours to generate them

A master dark built from 50 dark frames captured with Apogee Alta 
U8300 monochrome cooled at -30° for 600 seconds of integration time

Dead column



 Bias is similar to a Dark but it does not contain 
the thermal signal

 High end cameras having regulated cooler 
does not need bias if the temperature and the 
exposure time used to capture dark and flat 
frames are equivalent to the temperature and 
the exposure time used to capture the light 
frames

A master bias built from 50 bias frames captured with Apogee Alta 
U8300 monochrome cooled at -30° for 0 seconds of integration time

Dead column



 Flat frames allow making the portrait of all 
imperfections (artifacts) that occurs on the 
components that are parts of the optical train

 Unlike the dark and bias, flats are taken in 
presence of uniform light

 This can be the natural light of dusk or dawn 
or artificial light emitted by an 
electroluminescent panel

 I use an electroluminescent panel because it is 
much easier than using the natural light

A master flat built from 50 flat frames captured with Takahashi FSQ 106 
@ f/5, Astrodon 5nm H-alpha filter, Apogee Alta U8300 monochrome 

cooled at -30°, and an electroluminescent panel

Vignetting

Dust nodes

Vignetting

Fringe patterns 

caused by the CCD 

sensor



 A proper calibration must be done by subtracting the master 
dark from the light frame and by dividing the subtraction result 
by the master flat

 If the light frame is taken with different temperature or 
exposure time than the master dark frame 
 a series of bias frames must be taken at the same temperature than the light 

frames

 This series of bias frames must be combined to get a master bias frame

 The resulting master bias frame has to be integrated to the calibration 
process to make an adaptive subtraction of the preexisting dark frame

 Usually, I never use adaptive subtraction. I always prepare my 
master dark and flat at the same temperature and with the 
same integration time that I have used to capture the light 
frames
 I build and maintain a library containing all my calibration masters for all my 

instruments and for all the exposure, binning configuration and filters that I 
regularly use



 To follow the evolution of my sensors along the time, I redo my 
calibration masters every 6-8 months

 I take 50 frames of each kind of calibration frames (darks and 
flats) with the camera cooled at -30°C

 I use the software CCDStack® to build my calibration master

 To create a master dark, I use the create calibration master 
command in CCDStack

 This command allows generating clean dark master that can be 
used during several months

 Clean master dark, means that the cosmic rays that occur 
especially on long exposure must be removed to do not add 
unexpected noise to the light frame during calibration



 To generate clean dark master, CCDStack offers a good combining algorithm called 
“Clip Min/Max mean”

 This means that the highest and lowest pixel values are ignored from the series of 50 
frames. The remaining 45 values are averaged to create the master dark

 As cosmic rays are transient events that they occur only once, the resulting master 
dark is then free of cosmic rays

 Once the master dark is done, the next step is the generation of master flat

 To make a master flat, I also use 50 flat frames captured with an electroluminescent 
panel

 I capture 50 flat frames per filter available on my filter wheel

 The exposure time of each flat frame is adapted to the selected filter to avoid 
saturation

 To create a master flat, I use the create calibration master command in CCDStack

 This command subtracts the bias frame from each flat frame and then it averages the 
values to create the master flat



 Once, the master dark and flat are generated they can be used for calibration

 To calibrate all frames of my mosaic projects, I follow the workflow described below:

 Open CCDStack
 Open Windows File Explorer
 Select the files that belongs to one tile



 Drag & Drop the files into CCDStack

 Check if all selected files are listed in the image manager



 Open the calibration manager and specify the path to the file containing the dark master

 Go to the flat field tab and  specify the path to the file containing the flat master



 Click on “Apply to all” to calibrate all loaded images

 Save all calibrated image to a folder for further use
 Usually, I create a subfolder called “calibrated” in my project folder

 I use this subfolder to store all images once they have been calibrated

 Continue to calibrate images of next tile until all tiles of the mosaic project have been 
calibrated 



Flying bat and squid nebulae (12 panels mosaic)



 Once all monochromatic frames have been properly calibrated, all of them must 
be evaluated in term of quality

 This evaluation is very important because if the image stack contains one or 
several frames of poor quality, it will have a significant impact on the result

 Even if CCDStack provides powerful statistical data rejection algorithms that 
allow mixing frames of various qualities, the uses of frames with really poor 
quality provide a result worse than what we can get by simply excluding them 
from the stack

 That’s why the data quality evaluation process is so important



 With equatorial mount, the image is flipped on both axis (horizontal and vertical) 
when the mount is changing its pier side

 Before evaluating their quality, all the frames must have the same orientation

 

Frame captured when mount pier is in west 
meridian 

Frame captured when mount pier is in east 
meridian 

  
 



 To do that, SkySurveyor provides a good help by adding in the image filename the pier side where the 
mount was when the frame was captured

 To give the same orientation to all frames, the first step is to select a pier side East or West

 Once selected the same side must be used for all tiles of the mosaic project

 All frames of the opposite side must be flipped on both axis (horizontal and vertical)

 Usually, I use West orientation for all my frames but if the object is very high in altitude (close to the 
meridian) and if there is more East frames than West frames, the East orientation is preferred

 



 To change the frames orientation, I use the following workflow:

 Open MaximDL
 Open Window File Explorer
 Select all files that must be flipped and mirrored



 Drag & Drop the files to MaximDL
 Reverse the frame orientation with Edit->Flip and Edit->Mirror commands 

 Click the close button

 Click Yes to save the image
 Continue to reverse the frames orientation until all have been processed 



 To evaluate the quality of each individual frame by following the workflow described below:

 Open CCDStack
 Open Windows File Explorer
 Select the files that belongs to one tile



 Drag & Drop the files into CCDStack

 Check if all selected files are listed in the image manager

 Activate the DDP, and click auto scale in order to see all details in frames



 To make the first visual evaluation of all frames the list must be sorted from the lowest frame number 
to the highest frame number

 To do that, simply click the Name column

 To inspect each frame step by step, click the first frame and go across the list by pressing the down 
arrow on the keyboard

 The correct orientation and the overall quality (contrast and background level) is evaluated visually by 
comparing each frame with at least one other having a better visual aspect

 During this visual inspection, if at least one bad frame is found, then the bad frames must be removed 
from the list and if a frame is not correctly oriented it must be reoriented before continuing the 
evaluation procedure



 Its time to evaluate the quality of each frame by their FWHM value

 The point – spread function (PSF) is the result of blurring a point-source

 As FWHM is a constant measure of the PSF and the resolution 
regardless of intensity, it provide a good indicator about the quality of a 
frame

 To do that evaluation the list must be sorted from the lowest to the 
highest FWHM value

 To do that, simply click the FWHM column

Full Width at Half Maximum (FWHM) is 
constant regardless of star brightness



 Usually, I reject all frames having FWHM above 5 and keep only frames with 
FWHM above 4 after visual inspection and comparison

 At the end of the evaluation process, all the rejected frames must be deleted 
from the folder to keep only the calibrated frames that reach the expected 
quality level
 Remember which frame as the best quality to be able to quickly reuse it during alignment 

process



PacMan nebula



 The goal of registration is to align each frame on the same reference in order to be able to 
combine the signal of individual exposure into a single master frame

 To be correctly combined (stacked) the centroids of all stars must be exactly aligned at a 
subpixel level with their counterparts among all frames

 There are several reasons why stars become misaligned between frames:
 The data was taken on different nights

 The data was taken from different mount pier side

 The equatorial mount is not perfectly aligned to the celestial pole

 There is optical distortion caused by the atmospheric turbulences

 There are mechanical flexions on the optical train

 There are guiding and tracking errors

 The data was acquired by various optical system and/or sensors

 There is a natural drift between exposure

 There is a forced pixel drift between exposure (i.e. Dithering)

 The data was taken at difference focal length with different binning mode



 To achieve a correct alignment in all cases the frames must be offset, rotated, scaled and stretched

 If the frames are not correctly aligned the same objects will appear twice or multiple times on the master 
frame

 CCDStack contains a wide variety of alignment algorithms that can be used to make good alignment in all 
case of figure

 Usually, for deep sky imaging, I use CCDIS which allow aligning frames by finding and matching star patterns 
among the frame collection or Star Match that works well on frames captured with the same scale

 The challenge is to find a resampling algorithm that will have a minimum impact on the data during the 
alignment process

 As a best practice recommended by Adam Block in the book (Lessons from the Masters - Robert Gendler), I 
use the algorithm called Nearest Neighbor

 This algorithm only shifts frames to the nearest pixel and does not generate new pixels by interpolation



 To align the frames, I use the following workflow:

 Open CCDStack
 Open Windows File Explorer
 Select the files that belongs to one tile



 Drag & Drop the files into CCDStack

 Select the frame having the best quality to use it as reference image for the alignment
 Click on the menu Stack->Register



 Choose CCDIS or Star Match tab

 In CCDIS to make subpixel alignment always activate the high precision option

 Click “align all” button

CCDIS Star Match



 Once they are all aligned, click on the “Apply tab”

 Choose “Nearest Neighbor’’ and click on “Apply to All” button

 To check the correct alignment, I usually step through all frames
 If they are perfectly aligned there is no move between each frame

 Save all registered images to a folder for further use
 Usually, I create a subfolder called “registered” in my project folder

 I use this subfolder to store all images once they have been registered



Tadpole and flamming star nebulae (20 panels mosaic)



 Image stacking is a very powerful method that increases the 
signal-to-noise ratio and that increases the dynamic range of 
master light frame

 The effect of image stacking seems almost magical when we 
compares the signal of a single light frame and all information and 
details that are visible on the resulting master frame

 There is no magic behind the image stacking and the real 
explanation are easy to understand



 When the signal (photons emitted by a light 
source) are summed the relative noise is 
equal to the square root of the accumulated 
signal
 The difference between the amount of signal and the 

amount of noise is caused by the random nature of 
the noise

 As we can see in this graph, the signal is 
growing exponentially and the associated 
noise remains almost flat, this is why the 
effect of the stacking seems magical

 In regard of this, we see that the best 
number of frame for an image stack is 
somewhere between 10 and 40 frames
 Below 10 the SNR is poor and above 40 the required 

capture time become inefficient



 Another benefit provided by the image stacking is that it increase the dynamic range of the image

 Dynamic Range is the ratio between the brightest possible recordable value and the dimmest 
possible recorded value

 CCD sensor measures the light at each pixel by counting the photons that fall into a well (photosite)

 The deepness of the well (photosite) determines the dynamic range of a camera

 When a photosite receive more photons than what it can contains the pixel is saturated

 When a photosite receive few photons the well remain almost empty and close to the noise floor

 So, every experienced astrophotographers know that their challenge is to find a good balance 
between the faint and brightest light sources that are present in a frame

 If the frame integration time is too short, the faint light source will be destructed by the readout 
noise and in the other hand if the frame integration time is too long, the brightest light sources will 
be saturated

 The solution is to find an integration time that is not too short and not too long



 How the stacking increase the dynamic range?

 Usually, sensors used for deep sky imaging are 
able to record signal on 16bit counters

 This allows a dynamic range between 1 to 64 
killo shades

 The stacking algorithms are able to sum and 
record the signal on 32bit or 64bit counters

 This allows a dynamic range between 1 to 4.2 
billion of shades for 32bit (single precision) and 1 
to 184 billion of billions of shades for 64bit 
(double precision)

 

 

Noise floor 

Weakest signal 

close to the 

noise floor 

Brightest signal 

close to 

saturation level 

0 

65535 

3D plot of a single light frame that shows the signal colored in red and 
green hues and the noise floor colored in dark blue



 However, when stacking, the dimmest parts 
accumulate into higher values that escape the 
floor of the dynamic range, while 
simultaneously increasing the dynamic range as 
the brightest parts get brighter and brighter as 
more images are added to the stack

 So, the use of larger dynamic range at stacking 
allows avoiding saturation of the brightest parts

 The main advantage of increasing the dynamic 
range is that it provides more flexibility for 
image processing
 it becomes possible to stretch the image without increasing 

the background noise

 This becomes possible because increasing the 
dynamic range also increase the gap between 
the weakest signal and the noise floor

 

 

Noise floor 

Weakest signal 

close to the 

noise floor 

Brightest signal 

close to 

saturation level 

0 

65535 

3D plot of a single light frame that shows the signal colored in red and 
green hues and the noise floor colored in dark blue



 The main drawback of the stacking is that the imperfections that can exist on each frames 
are also stacked and this will affect the quality of the overall image

 To avoid that, CCDStack® offers powerful statistical data rejection algorithms that allow 
excluding imperfections that can exist on individual frames

 Due to the variation of the seeing, the strength of the signal recorded on each frame is not 
constant along time

 To equalize the variation of the signal level of each frame, we must normalize them

 Normalizing a frame means that a multiplication factor (weight) is applied to every frame 
in order to increase/decrease the signal

 The weight of each frame is calculated by comparing each frame with a reference frame



 To stack the frames, I use the following workflow

 Open CCDStack
 Open Windows File Explorer
 Select the files that belongs to one tile



 Drag & Drop the files into CCDStack



 Select the frame having the best quality to use it as reference image for normalization
 Click on the menu Stack->Normalize->Control->Both



 Select background area and click OK to validate



 Select highlight area and click OK to validate



 The calculated weight of each frame is displayed in the image manager



 Activate the option that shows the rejected data



 Click on the menu Stack->Data Reject->Procedures and select the “STD sigma reject” rejection 
algorithm 

 You can either enter a value between 1% to 2% of the top image or directly enter a value in the factor

 Factor must be between 1.8 to 2.3 and the iteration limit must be set to 2 to reject at most two values. 
Press “Apply to All” button to process data rejection on each frames



 The rejected pixels are highlighted in red on each frame

 Before stacking, each frame must be inspected to check if artifacts and imperfections have been 
correctly rejected 
 If not, the data rejection parameters must be adjusted and the rejection algorithm must be applied again



 Click on the menu 
 Use Stack->Combine->Sum to create a luminance master frame 

 Use Stack->Combine->Mean to create a monochromatic chrominance master frame

 Once generated, the master frame is added to the image manager



 Before saving the master frame, it must be carefully inspected to be sure that all imperfections and 
artifacts have been totally rejected 
 If not, the data rejection parameters must be adjusted, the rejection algorithm must be applied again and a new master frame must 

be generated

 Save the master frame
 Usually, I create a subfolder called “stacked” in my project folder

 I use this subfolder to store all master frames that will be used to create mosaic master frame by stitching all individual tile master 
frame

 To give a useful filename to the master frame, I follow this naming convention:

Sum Rosette-FoxFur_P20_RA06+34+12_DEC+05+02+30_530_1x1_6000_10_H-a.fit

Mosaic project name
Tile number

Right ascension coordinate of the center
Declination coordinate of the center

Focal length in millimeters
Binning

Total exposure time in seconds
Subframe number

Filter name

Stacking operation



Orion (180 panels mosaic)

http://eapod.eu/26-february-2017-orion/ https://apod.nasa.gov/apod/ap160413.html



 This is the second most challenging phases in the mosaic project life cycle  

 To accomplish that we must be patient and resilient, indeed there is two major cliffs that must be overcome: 
 The first one is to register each tile master frames together to build a unique mosaic master frame

 The second one is to merge all registered tile master frames into a unique seamless* image 

*seamless means that the overlap between tiles must not be visible on the final image

 Several workflows exist to stitch a mosaic. Mainly, I use a workflow that merge all monochromatic master tile 
frames captured with the same filter into a unique monochromatic mosaic master frame

 All mosaic master frames can be symmetric (merged with the same number of tiles and covering the same field) or 
asymmetric (merged with various numbers of tiles and not covering the same field)

Symmetric stitching workflow Asymmetric stitching workflow



 This workflow is the most demanding in term of registration but in the other hand it provides the 
greatest control at processing

 The time we will spend for stitching is directly proportional to the number of tiles that the project 
contains:
 The more is the number of tiles, the more the risk of mismatches increase

 The more is the mismatches, the more the time needed to solve them is long

 To make an example, I spent 120 hours to complete the asymmetric stitching workflow that allowed 
to merge more than 180 monochromatic frames of the following mosaic

 For this mosaic, the workflow is asymmetric because the mosaic field is covered at 100% by H-alpha, 
Red, Green, and Blue data and partially covered by OIII, SII, NIR and Luminance data



 To register and to merge master tile frame, I usually work with two different software: RegiStar and 
PixInsight

 Registar is software that is only specialized in automatic image registration for astrophotography

 Auriga Imaging describes RegiStar as following:

RegiStar is a one-of-a-kind program that fully automates the task of aligning digital astronomical
images. RegiStar shifts, rotates, flips, and deforms as needed to precisely align images, even if they are
at different scales or orientations or have been produced with different optical systems

 PixInsight is an image processing platform specialized in astrophotography offering a wide variety of 
tools and processing algorithms

 Pleiades Astrophoto describes PixInsight as following:

PixInsight is our main development project. It is an image processing platform specialized in
astrophotography, available natively for FreeBSD, Linux, Mac OS X and Windows operating systems.
PixInsight is both an image processing environment and a development framework. It is the result of a
dynamic collaboration between like-minded astrophotographers and software developers, who are
constantly pushing the boundaries of astronomical image processing with the most powerful toolset
available



 In my experience, I found that PixInsight is more efficient for merging frames and RegiStar
is more efficient for registering frames particularly if they have different scales or 
orientations or have been captured with different optical systems

 But both are able to stitch a mosaic from A to Z

 Depending on the issues encountered while stitching, I use only RegiStar, only PixInsight
or both together

Registar PixInsight



 With RegiStar, I use the following workflow:

 Open RegiStar
 Load two tiles that overlaps each other’s

 

 #20 #26 



 Click on menu Operations->Register (or press F2)

 Choose Union and click on “Register” button



 The tile in red #20 is automatically registered with the tile in blue #26

 Before merging the tiles together, they must be calibrated first

 Calibration means equalization of their signal level. To be correctly calibrated both tiles 
must share at least 1000 pixels

 

Registered 



 To calibrate the red tile #20 against the blue tile #26, click the menu Operations-
>Calibrate (or press F7)

 Select “Just this image” and the image #26 as reference and click the “OK” button



 After calibration, the result is displayed in a new window

 Now, the calibrated tiles can be combined together to generate a single frame

 

Calibrated 



 To combine the red tile #20 with the blue 
tile #26, click the menu Operations-
>Combine (or press F4)

 There are several functions that can be 
used to combine, I usually use Overlay
because it generally gives the best result

 Overlay specifies that images are 
superimposed in a specified order, with 
each image replacing those below it (blue 
#26 replace red #20)

 Press “OK” to combine



 After combine, the result is displayed in a new window

 

Combined 



 Continue with the same workflow until all tiles get assembled

 Save the monochromatic mosaic master frame on the project folder



 With PixInsight, I use the following workflow

 Open PixInsight
 Load two tiles that overlaps each other’s

 

 #20 #26 



 Press CTRL + A on both to apply screen transfer function to see the images details

 

 #20 #26 



 From Process Explorer, select the StarAlignment
process

 Select the tile #20 as a reference image, activate 
the distortion correction and adjust the number 
of iterations and residual parameters if needed
 Try first with default value and adjust them later if the 

distortion can’t be corrected with default settings.

 Check frame adaptation to equalize the signal 
level of the tile #26 against the tile #20

 Drag & Drop the triangle located at bottom left 
on the tile #26 to start the registration and 
combine process

 



 At the end of the process, a new frame is displayed to display the new image details press 
CTRL+A

 

Registered, 

Calibrated 

and 

Combined 



 Continue with the same workflow until all tiles get assembled



 Save the monochromatic mosaic master frame in the project folder
 Usually, I create a subfolder called “stitched” in my project folder



 If we compare the results made with the two workflows: in red the mosaic frame built with 
PixInsight and in blue with Registar

 In that example, the results look exactly the same; there are no apparent differences and 
the result looks almost seamless. The adjustments that are required to get a perfect result 
only require little adjustments that can be done later with proper mask and curve tools in 
PhotoShop

 

  



 The raw data used to build the example are very homogeneous; the 4 frames 
share the same scale (dimensions and pixel FOV) and almost the same quality
 almost the same SNR and few distortions

 The use of homogeneous data does not allow figuring out any differences 
between the two workflows

 But in case of use of heterogeneous data (various dimensions, pixel FOV, quality 
and SNR), I found that Registar is the best tool to achieve an accurate registration 
of every frames



 In the case that the mosaic master frame built by using the standard stitching 
workflows does not give a seamless result. PixInsight is able to create smooth 
transition between tiles with two processes BackgroundExtraction (ABE and 
DBE) and  GradientMergeMosaic (GMM)

 Very often the seams appears between tiles because of a light pollution gradient

 So before using GMM process try to remove the light pollution gradient on each 
contaminated frame

 Once the gradient is removed, the tiles must be registered against the previously 
generated mosaic master frame

 Once they are registered, they can be merged by using the GMM process



 Usually, I start with AutomaticBackgroundExtraction (ABE) because it performs a linear least square 
fit and attempts to remove gradients automatically without user interactions

 As first step, I apply  ABE on a light polluted frame without correction

 I carefully inspect  the generated background model and if it looks good, I subtract it from the light 
polluted frame

Background 

model



 If light pollution gradient are difficult to eliminate, I use DynamicBackgroundExtraction (DBE) to 
manually build a custom background model

 As first step, I generate samples and I apply DBE without correction

 I carefully inspect  the generated background model and if it looks good, I subtract it from the light 
polluted frame

Background 

model



 Once the gradient has been properly removed, the gradient mosaic merge GMM can be applied 
according the following workflow:

 Open PixInsight
 Load the previously generated mosaic frame
 Open the StarAlignment process

Select previously generated mosaic frame as reference image

Enable distortion correction

Choose Register/Match Images working mode

Enable frame adaptation

Add files that must be registered

Define output settings

Apply

Registered



 Load the registered frame and press CTRL+A to see the details

 Inspect each frame and check if they are correctly registered

Top left frame Top right frame

Bottom left
frame

Bottom right 
frame



 Open the GradientMergeMosaic process

Add files and order them for the merge process

Set overlay  as type of combination

Apply

Set shrink radius to 1

Set feather radius to 10

Enable generate mask

Merged Masks



 Sometimes pinch artefacts might appears on the merged mosaic
 Pinch artefacts are generated by bright stars located  near the edge of two or more tiles
 They can be removed or attenuated by increasing the GMM parameters shrink and feather radius

Pinch artefact

Increase shrink radius

Increase feather radius
Apply



 With a shrink radius at 6 and feather radius at 10 the pinch artefact  has been completely removed



 Once all mosaic monochromatic frames are seamlessly combined, they must be registered together in order to use 
them from creating the luminance and the chrominance master frames

 To do that registration, I usually use Registar because the registrations algorithms are very well adapted for that job 
but PixInsight work well too

 Once all monochromatic master frames are properly registered, they must be converted to 16bit TIF image file 
format

 Why TIF? because TIF are natively compatible with PhotoShop

Registered



Cygnus Loop (6 panels mosaic) 



 The luminance master frame is very important to bring out the faint structural 
details into the image

 It's very important to carefully process it in order to maximize the quality of the 
final image

 To create the luminance master frame, I mostly use the H-alpha narrowband data 
as a background data because it allows to reveal small structural details

 To improve the details on my luminance master frame, I usually add additional 
data such as

 Broadband luminance or RGB

 Narrwoband OIII and SII

 Sometimes NIR



 Depending on the gas distribution inside the nebula, H-alpha data will not allow to reveal 
the entire body of the nebula because the light coming from those areas is emitted in 
other bandwidth
 In this case, the luminance master frame must be created by bringing OIII and SII data to H-alpha

 To combine all available data into the luminance master frame, I derived a method 
developed by Rogelio Bernal Andero in the book (Lessons from the Masters - Robert 
Gendler)

 This method allows to split an image in two separate parts : one with large scale 
structures (LSS) and another one with small scale structures (SSS)

 To improve the SNR of the luminance master frame, the H-alpha, OIII and SII images can 
be combined with the following formula :
 LSS(H-a) + LSS(OIII) + LSS(SII) = LSS(HOS)

 LSS(HOS) + SSS(H-a) = Luminance

NOTE : Using only small scale details of H-alpha allows to do not add additional noise to the luminance.



 If you have broadband RGB data you can also combine them into the luminance master 
frame with the following formula:

 LSS(H-a) + LSS(OIII)xW(OIII) + LSS(SII)xW(SII) + LSS(R)xW(R) + LSS(G)xW(G) + LSS(B)xW(B) = LSS(HOSRGB)

 LSS(HOSRGB) + SSS(H-a) = Luminance

W() is the weight applied to one monochromatic master frame 

 If you have broadband luminance data you can also combine them into the luminance 
master frame with the following formula:

 LSS(H-a) + LSS(OIII)xW(OIII) + LSS(SII)xW(SII) + LSS(L)xW(L) = LSS(HOSL)

 LSS(HOSL) + SSS(H-a) = Luminance

W() is the weight applied to one monochromatic master frame 

NOTE : Using only small scale details of H-alpha allows to do not add additional noise to the luminance.



 If OIII data contains good small scale details (e.g. Veil nebula). You can bring them into  
the luminance master frame with the following formula :
 LSS(H-a) + LSS(OIII)xW(OIII) + LSS(SII)xW(SII) = LSS(HOS)

 SSS(H-a) + SSS(OIII)xW(OIII) = SSS(HO)

 LSS(HOS) + SSS(HO) = Luminance

W() is the weight applied to one monochromatic master frame 

 If SII data contains good small scale details (e.g. Veil nebula). You can also bring  them 
into the luminance master frame, with the following formula :
 LSS(H-a) + LSS(OIII)xW(OIII) + LSS(SII)xW(SII) = LSS(HOS)

 SSS(H-a) + SSS(OIII)xW(OIII) + SSS(SII)xW(SII) = SSS(HOS)

 LSS(HOS) + SSS(HOS) = Luminance

W() is the weight applied to one monochromatic master frame 

NOTE : Using small scale data of OIII and/or SII is sometimes counter productive because depending on the object 
it brings few details and a lot more noise.



 While stitching, if we have used an asymmetric  workflow all monochromatic mosaic 
master frames does not cover the whole mosaic field

 In that case the monochromatic mosaic master frames must be properly added to the 
luminance master frame by using masks and curves

Asymmetric stitching workflow



 In H-alpha data M78 is almost invisible
 This is because M78 is a reflection nebula and H-alpha filter only works with emission nebula
 To make M78 visible in the luminance master frame, I must combine the data captured with 

broadband filters with the H-alpha 

M78



 To do that, I load the broadband master frame of M78 on top of my luminance master frame
 The frame containing M78 must have been previously registered with the luminance master frame

M78



 Then I draw a mask that surround M78 
 I use feather function to soften the mask

M78



 I add curve as clipping mask of M78 layer and I play with curves to adjust M78 against the master 
luminance frame

M78



 Repeat the same workflow to merge all monochromatic master frame into the luminance master 
frame
 For example: to avoid saturation of M42, I have used the same workflow to include a HDR processed version of M42 into my 

master luminance

M78

M42 processed with
GradientHDRComposition

in PixInsight



 This process allows to enriches the luminance by adding various data coming from different 
instruments, scales and sensors
 When adding partial data to the luminance master frame, don’t forget to do the same on the chrominance master frames 

otherwise the added area will not be colored correctly during the final LRGB composition



HOS_LSS+SSS.tif

Ha

SII

OIII

Ha

SII

OIII

LSS SSS

optional

optional

Pixel math
Screen blending Screen blending

LUMINANCE MASTER



 Open the file mosNGC1499_8P-H.tif (original H-alpha image) in PixInsight
 Open MultiscaleMedianTransform

Select 5 layers

Disable layers 1 to 5

Select Lightness (CIEL L*)



Apply

 Save the image to H-LSS.tif
 Repeat the process for original SII and OIII images

NOTE : RGB data can also be used to improve the SNR.

 Apply MultiscaleMedianTransform on the image
NOTE : Small scale details and stars have been properly removed from the image



 Open file H-LSS.tif in Photoshop
 Place files O-LSS.tif and S-LSS.tif on top of the Background layer
 Choose Screen blending mode for both

NOTE : To equalize the amount of signal added by additional layer you can lower the percentage of opacity.

O-LSS.tif and S-LSS.tif

Screen blending mode
Percentage of opacity



 Flatten the image
 Save the image to LSS_HOS.tif

At this level the signal of all data is combined into a single image



 Go back to PixInsight
 Open the file mosNGC1499_8P-H.tif (original H-alpha image) and rename the tab H
 Open the file H-LSS.tif (H-alpha large scale structure)
 Open PixelMath

Tab H Tab H_LSS

Type formula: H – H-LSS

Check Rescale result

Select Create new image

Apply

 Apply PixelMath

NOTE : That the newly created image contain only small scale details including stars

 Save the image to H-SSS.tif



 Open files LSS_HOS.tif and H_SSS.tif
 Open HistogramTransformation

 Stretch the H_SSS image to increase the signal of small scale details
NOTE: Take care to do not crop the peak

Apply

Move handles to stretch



 Open PixelMath Type formula: LSS_HOS + H_SSS

Check Rescale result

Select Create new image

Apply

 Apply PixelMath

NOTE : If the details are not visible enough then close the new image, undo HistrogramTransform on H_SSS 
image and go one step backward to make a better stretching

 Save the image to HOS_LSS+SSS.tif



At this level the image contains the small structural details of H-alpha embedded 
with the large scale structures of all available data

HOS_LSS+SSS.tif



Soul and heart nebulae (8 panels mosaic)



BEFORE AFTER

HOS_LSS+SSS.tif HOS_LSS+SSS_exp+.tif



 Open PhotoShop
 Open the file HOS_LSS+SSS.tif
 Select the nebula with the lasso tool

NOTE: Take care to do not select the background

Select->Modify->Feather
Feather Radius : between 100 and 150 pixels
Press Ok to apply



 Add Exposure Adjustment Layer with the previous selection as mask
 Increase the exposure

NOTE : Take care to do not saturate

Exposure adjustment layer 
with mask

Exposure control slider

 Save the image to HOS_LSS+SSS_exp+.tif

Saturated

Burned region



BEFORE AFTER

HOS_LSS+SSS_exp+.tif HOS_LSS+SSS_exp+_sh.tif



 Open file HOS_LSS+SSS_exp+.tif

Image>Adjustments>Shadow/Highlights



Adjust Shadows amount 
percentage

Adjust Highlights amount 
percentage

Adjust 
Brightness

Adjust Midtone
Contrast

Apply

 Adjust  Shadows/Highlights amounts until you get the expected result
 Save the image to HOS_LSS+SSS_exp+_sh.tif



BEFORE AFTER

HOS_LSS+SSS_exp+_sh.tif HOS_LSS+SSS_exp+_sh_acdnr.tif



 Open PixInsight
 Open HOS_LSS+SSS_exp+_sh.tif
 Open ACDNR

Adjust StdDev
Value between 1 and 1.5 pixels are 

good to remove high-frequency noise

Adjust Number of Iterations. 
To get a good result you must 

reduce the Amount and increase 
the number of iteration

Uncheck Apply in 
Chrominance tab

NOTE: To learn more about noise reduction and edge protection, go to 
http://www.deepskycolors.com/PixInsight/NoiseReduction.html

Adjust Amount
Value between 

0.1 and 1



 Apply ACDNR on the image

Apply

 Save image to HOS_LSS+SSS_exp+_sh_acdnr.tif

NOTE: If the noise reduction is too weak or too strong, you can undo and ajust parameters

Too strong noise reduction

Too weak noise reduction



BEFORE AFTER

HOS_LSS+SSS_exp+_sh_acdnr.tif HOS_LSS+SSS_exp+_sh_acdnr_star-.tif



 Open PixInsight
 Open file HOS_LSS+SSS_exp+_sh_acdnr.tif
 Open StarMask

Set Large-Scale to zero

Increase Small-Scale to 2 or more

Decrease Smoothness to 5 or less

Check Binarize

Increase Compensation to 4 or more



 Apply StarMask

Apply



 Duplicate StarMask
 Open MorphologicalTransformation

Apply

Duplicate

Select Dilatation Operator

Set number of 
iterations to 2 or more

Size 7 (49 elements)

Select circular structure



 Open PixelMath

Type formula: star_mask + 
star_mask_clone

Check Rescale result

Select Create new image

Apply

Zoom on merged 
star masks



 Open Convolution

Apply

Adjust Standard Deviation to 
get a progressive gradient

Adjust Shape

Zoom on star mask after 
convolution



 Drag & Drop star mask to the image

NOTE: To be able to see the image behind the mask you must hide the mask



 Open MorphologicalTransformation

Apply

Select Morphological Selection

Set number of 
iterations to 2 or more

Size 7 (49 elements)

Select circular structure

Adjust Selection to 0.30

 Save image to HOS_LSS+SSS_exp+_sh_acdnr_star-.tif



BEFORE AFTER

HOS_LSS+SSS_exp+_sh_acdnr_star-.tif HOS_LSS+SSS_exp+_sh_acdnr_star-_msh.tif



 Open PhotoShop
 Open file HOS_LSS+SSS_exp+_sh_acdnr_star-.tif
 Select the nebula with the lasso tool

Select->Modify->Feather
Feather Radius : between 100 and 150 pixels
Press Ok to apply



Image>Adjustments>Shadow/Highlights



 Save image to HOS_LSS+SSS_exp+_sh_acdnr_star-_msh.tif

Adjust Shadows amount 
percentage

Adjust Highlights 
amount percentage

Adjust 
Brightness

Adjust Midtone
Contrast

Apply

NOTE: The shadows and highlights process is effective only in the selected area 



BEFORE AFTER

HOS_LSS+SSS_exp+_sh_acdnr_star-_msh.tif mosNGC1499_8P-L.tif



 Open PhotoShop
 Open file HOS_LSS+SSS_exp+_sh_acdnr_star-_msh.tif
 Select the nebula with the lasso tool

Select->Modify->Feather
Feather Radius : between 100 and 150 pixels
Press Ok to apply



Filter->Sharpen->Smart Sharpen

Select Sharpen

Adjust Amount

Adjust Radius



Select Highlight

Adjust Amount

Adjust Radius

Adjust Tonal 
Width



Select Shadow

Adjust Amount

Adjust Radius

Adjust Tonal 
Width

Apply



 Save image to mosNGC1499_8P-L.tif



At this level the luminance is done.

mosNGC1499_8P-L.tif



Jellyfish nebula



RAW data

SIIHa OIIIHa

L R G B

LRGB composition



 Open PixInsight
 Open files mosNGC1499_8P_H.tif, mosNGC1499_8P_O.tif and mosNGC1499_8P_S.tif
 Open LRGBComposition process

Uncheck L channel

Select SII image 
on R channel

Select H-alpha 
image on G 

channel

Select OIII image 
on B channel

Apply

mosNGC1499_8P-H.tif mosNGC1499_8P-O.tif mosNGC1499_8P-S.tif



 Open ACDNR process

Adjust StdDev
Value between 1 and 1.5 pixels are 

good to remove high-frequency noise

Adjust Number of Iterations. 
To get a good result you must 

reduce the Amount and increase 
the number of iteration

Check Apply in
Lightness tab

Adjust Amount
Value between 

0.1 and 1



 Save the image as SHO_ColorMap.tif

Apply

Adjust StdDev
Value between 1 and 2.0 pixels are 

good to remove high-frequency noise

Adjust Number of Iterations. 
To get a good result you must 

reduce the Amount and increase 
the number of iteration

Check Apply in
Chrominance tab

Adjust Amount
Value between 

0.1 and 1



 Save image to mosNGC1499_8P_H_hdrto.tif

 Open Photoshop
 Open file mosNGC1499_8P_H.tif

Image->Processing->HDR Toning

Add control points and adjust them 
to make a S shape

Reduce Highlights to avoid saturation

Increase details

Apply



 Open file SHO_ColorMap.tif



 Place file mosNGC1499_8P_H_hdrto.tif on top of the SHO_ColorMap.tif

mosNGC1499_8P_H_hdrto.tif 



 Flatten the image

Luminosity blending mode

Adjust opacity if needed



Soft Light blending mode

Adjust opacity

Areas where the blend color is lighter than 50% gray are lightened
Areas where the blend color is darker than 50% gray are darkened

 Duplicate background layer



 Add Color Balance adjustment layer

 Flatten the image

Shadows

Move slider to green to remove magenta from background

Color Balance



 Select Image->Mode->Lab Color
 Add Hue/Saturation adjustment layer

 Flatten the image
 Image->Mode->RGB Color

Hue/Saturation

Move Hue slider to the opposite side 
(magentas)



Switch 

Lab Color

Mode

Shift Hue

with

Hue/Saturation

AdjLayer

Switch to

RGB Color Mode

Shift Hue

with 
Hue/Saturation

AdjLayer

Adjust 

with Selective 
Color

AdjLayer 1..n
iterations

NOTE: Sometimes to get good colors you must slightly switch the green hue to red hue within more that one iteration

Steps required only if there is more than one iteration

Mandatory steps



 Add Selective Color adjustment layer Select Reds colors

Decrease Cyan to densify Red

Selective Color

Decrease Magenta to get Orange Hue

Increase Yellow to reinforce Orange Hue



 Add a second Selective Color adjustment layer Select Magentas colors

Increase Cyan

Selective Color

Decrease Magenta to remove purple 
halo surrounding the stars

Decrease Yellow



 Continue to add more Selective Color adjustment layers until you get the expected hue

Selective Color

Select Reds colors

Decrease Cyan to 
densify red



 Add Photo Filter adjustment layer

Photo Filter

Select Cooling Filter (LBB)

Adjust Density



 Add Vibrance adjustment layer

 Flatten the image
 Save image to mosNGC1499_8P-RGB.tif

Vibrance

Adjust Saturation



At this level the chrominance is done.

mosNGC1499_8P-RGB.tif



Bubble Nebula



 LRGB composition allows to blend luminance with chrominance
 Luminance brings the structural details
 Chrominance brings the colors

LUMINANCECHROMINANCE LRGB COMPOSITION

mosNGC1499_8P-RGB.tif mosNGC1499_8P-L.tif mosNGC1499_8P-LRGB-SHO.tif



 Open chrominance image mosNGC1499_8P-RGB.tif
 Place the luminance image mosNGC1499_8P-L.tif on top of the chrominance image

Luminosity blending mode

Luminance imageChrominance image

Adjust
Percentage of opacity



 Select the orange region with the lasso tool

Select->Modify->Feather
Feather Radius : between 100 and 150 pixels
Press Ok to apply
Select->Inverse



 Add Color Balance adjustment layer with the selection as mask

Color Balance with mask

Select Highlights

Move slider to Cyan

Move slider to Blue



 Add Hue/Saturation  adjustment layer with the same mask

Hue/Saturation with mask

Move slider to left



 Inverse mask
 Add Selective Color adjustment layer with the inverted mask

Selective Color with inverted mask

Select Reds colors

Decrease Cyan to densify Red

Decrease Magenta to get Orange Hue

Increase Yellow to reinforce Orange Hue



 Select the blue region of the nebula with the lasso tool

Select->Modify->Feather
Feather Radius : between 100 and 150 pixels
Press Ok to apply



 Add Photo Filter adjustment layer with the previous selection as mask

Photo Filter with mask

Select Cooling Filter (82)

Adjust Density



 Add Photo Filter adjustment layer with the mask that select only the orange area

Photo Filter with mask

Select Yellow Filter

Adjust Density



 Select the nebula with the lasso tool

Select->Modify->Feather
Feather Radius : between 100 and 150 pixels
Press Ok to apply



 Add Vibrance adjustment layer with selection as mask

Vibrance with mask

Decrease vibrance

Increase saturation



 Add Selective Color adjustment layer

Selective Color

Select Reds colors

Increase Yellow Hue



 Flatten the image
 Save the image to mosNGC1499_8P-LRGB-SHO.tif

Select Magentas colors

Decrease Magenta Hue



At this level the LRGB composition is done.

mosNGC1499_8P-LRGB-SHO.tif



https://www.facebook.com/david.lindemann.92

http://www.astrobin.com/users/dlindemann/

http://deepskyentropy.blogspot.ch/

Thank you for your attention 
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